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Executive Summary 

The regional economy, quality of life and tourism rely on clean water in Lake 
Champlain and its surrounding basin. This project explored elements of this 
relationship between water quality and property valuation, tourism 
expenditures and regional economic activity at various scales. 
 

At the parcel scale, both single family residential and seasonal home 
purchasers associated higher water quality with increased selling price. A one 
meter increase in water clarity is equated with a nearly 3% average increase 
in single family home value, and a 37% average increase in seasonal home 
value. Proximity to the Lake also contributes significantly to property 
valuation. Single family and seasonal residences within 100 m of Lake 
Champlain are expected to sell for nearly 30% and 49% more than similar 
residences that are located outside this area. Scenario analysis of changes in 
total phosphorous in the Lake from both climate change and meeting legal 
maximum daily load targets found that increased loading associated with 
climate change is estimated to result in a $7,000 average price decrease for 
single family dwellings, while reduced loading from TMDL implementation 
would result in a $15,200 average price increase for single family dwellings. 
 
At the scale of lake-side towns, water clarity during the peak summer months 
of July and August indicate a significant impact on lodging expenditures, an 
indicator of tourism spending more broadly. A linear regression model 
estimated a $2,303 increase per average lodging unit per meter of water 
clarity increase. Extrapolating to the five-town scale concludes that a one-
meter improvement in water clarity is expected to lead to a 10% increase 
($110,544) in room expenditures for the month of August alone. 
 
At the regional scale an input-output model was constructed for a six-county 
lakeshore economy in Vermont and New York. County-level employment, 
income, industry and household characteristics were used to assess the 
economic flows among sectors. The input-output model suggests that for 
each dollar of labor income required within lake-related tourist sectors an 
additional $0.57 in labor income through indirect industry inputs and induced 
impacts from additional spending of households will be generated. Similarly, 
each dollar of value-added (taxes, property income, profits) income generated 
in tourism-related sectors generates another $0.62. In terms of employment, 
every new job related to the lake tourism economy creates an additional 0.4 
jobs to support indirect and induced activities. The $300 million estimated 
annual tourist expenditures in Vermont’s four main lakeside counties generate 
an additional $72.75 million in spending and nearly 1,070 jobs. Extrapolating 
from the town-scale model, a one-meter decrease in water clarity during the 
months of July and August would lead to the loss of 195 full-time equivalent 
jobs, a $12.6 million reduction in tourism expenditures and a total economic 
reduction of nearly $16.8 million. 
 

This analysis represents a snapshot in time. The example of Georgia, VT 
underscores the importance of understanding how changes over time (i.e. 
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downward trending water quality) might affect real estate transactions, 
vacation rentals and tourism expenditures as losses in any of these sectors 
are further magnified when considering their effect on employment and 
indirect expenditures. Moving forward, scenarios ranging from individual 
events (e.g. fishing tournaments) to long-term environmental and economic 
conditions could be further analysed. Building on this framework could allow 
for rapid assessment of land use plans, zoning regulations, and environmental 
restoration, while additional scenario analysis could inform regional, 
integrated economic development and watershed management planning. 
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1 Tasks Completed 

1. Literature review: (Project Outline Task 3) Identified and documented 
relevant literature resources in a searchable database. The database includes 
a list of commonly used attributes for the estimation of hedonic models related 
to lakes and/or water quality. Each article (entry in the database) contains a 
brief summary of the publication, keywords that describe it, model parameters 
(for articles detailing hedonic analysis) and a link to the article so that 
interested staff are able to read the article in its entirety. 

 

2. Data collection and gap analysis: (Project Outline Task 4) Collected 
existing data from publically available sources, and derived additional data 
from these existing data layers. Corresponding documentation for all of the 
derived data is included in Appendix I and stored in an Excel Workbook. Data 
collection for the econometric models was largely informed by the results of 
the literature review. Data for the input-output model was purchased from 
implan.com and includes detailed economic and employment data at the 
county level for both New York and Vermont. Data gaps for the econometric 
models were identified, and, when possible, proxy data were developed for 
inclusion in the model. 

 

3. Econometric models: (Project Outline Task 6) Econometric models were 
developed to understand the relationship between Lake Champlain, its water 
quality and residential property ownership and tourism expenditures within the 
region. At the parcel scale, hedonic price models were developed for single 
family residences and seasonal second homes (i.e. camps) using real estate 
transaction data and other ancillary data. At the town scale, a model of 
lodging expenditures was created using water quality and room receipts data. 
The models were explicitly designed with lake water quality parameters so 
they could be used for modelling alternative future conditions. 
 

4. IMPLAN SAM model: (Project Outline Task 5) Characterized economic flows 
within the Lake Champlain shoreline economy to understand the economic 
relationships among employment sectors and the contributions from seasonal 
property ownership and tourism expenditures related to lake visitation and 
use. The lake economy was defined to include the four Vermont and two New 
York counties that make up the majority of the Lake Champlain shoreline.  An 
analysis of lakeside communities in Grand Isle and Franklin counties of 
Vermont with a predominance of lake-based summer tourism provided the 
basis of modelling the influence of water quality on tourism expenditures. 
 

5. Scenario analysis: (Project Outline Task 7 & Task 8) Scenario analysis was 
used to explore how changes in current water quality conditions might affect 
home ownership, tourism expenditures and their relative contributions to the 
regional economic system. Each of the models described above includes a 
water quality parameter to enable scenario analysis for estimating changes in 
economic returns from private property values, tourism expenditures and 
regional economic flows. Working in cooperation with regional experts (e.g. 
LCBP Technical Advisory Committee) a set of scenarios was identified and 
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implemented for each of the models and compared against the baseline 
conditions.  
 

2 Project Introduction 

Water quality in Lake Champlain is a strong determinant of regional economic 
activity. From private property ownership along the lake shore, to the number 
of tourist visits and their expenditures, to broad patterns of economic 
development, the livelihoods of a broad range of actors are dependent on 
access to clean water. The quality of the water also has implications regarding 
the need for infrastructure development, most prominently the need for water 
filtration capacity to provide a reliable supply of potable water. Land use and 
land cover throughout the basin plays an important role in regulating the 
quality of water in the lake, filtering pollutants, limiting erosion and sediment 
transport, sequestering and storing carbon and offering diverse recreational 
opportunities, among other things. The interconnected nature of the 
landscape and the actors that shape it mean that changes in land use or land 
management may serve to enhance ecosystem services locally while at the 
same time limiting overall service delivery throughout the region.  
 
Ecosystem services – the benefits provided by nature to humans – are 
increasingly used to frame the interdependency between environmental 
conservation and economic development. The growing interest in using 
ecosystem services in decision making has prompted a range of analytic 
methods and software tools to quantify their provision, delivery and economic 
valuation. Research approaches have included using geographic information 
systems (GIS) to map and value ecosystem services using spatial data (Eade 
and Moran 1996, Chan et al. 2006, Raudsepp-Hearne et al. 2010), deriving 
economic value by applying a transfer function to specific land use / land 
cover types (Costanza et al. 1997), and more recently developed software 
tools such as Integrated Valuation of Ecosystem Services and Tradeoffs 
(InVEST) (Kareiva et al. 2011) and the Artificial Intelligence for Ecosystem 
Services (ARIES) modeling platform (Villa et al. 2009).  
 
A central tenet of the conceptual model of the region is the acknowledgement 
that sustaining a high quality of life within the basin requires healthy, 
functioning ecosystems capable of producing and delivering ecosystem 
services. Generally speaking, the challenges for developing effective, 
sustainable watershed management plans are two-fold: 1) Connect the 
biophysical, ecological, and socio-economic characteristics of the basin to the 
supply of freshwater ecosystem services generated by water quality and the 
demand for those services by various constituencies; and 2) Quantify the 
benefits delivered and values ascribed to ecosystem services across multiple 
spatial scales by those constituencies. These challenges define the 
complexity of the coupled natural-human system that is the Lake Champlain 
basin, within which multiple, interconnected ecosystem services influence and 
are influenced by water quality. This project focused on the latter of the two 
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challenges by developing econometric models to relate indicators of water 
quality to local to regional economic expenditures.. 
 
The project approach is designed to quantify the value of clean water in Lake 
Champlain at multiple spatial scales for two primary classes of beneficiaries, 
residential property owners and tourists. Each of these beneficiary groups has 
their own expectations for the condition of the Lake and in the case of 
residential property owners, a financial stake in an increase (or decrease) in 
local to regional water quality. For tourists, poor water quality conditions within 
the Lake and its surrounding basin may lead to the selection of alternative 
destinations, taking with them the direct, indirect and induced expenditures 
that are a critical component to a thriving regional economy. 
 
This multi-scale approach follows the conceptual framework of the Millennium 
Ecosystem Assessment (MEA) (2005) by allowing us to consider exogenous 
drivers of change as well as the differential outcomes that policy actions may 
have throughout the basin, depending on the level of demand for a given 
service and the presence of specific types of beneficiaries. It also offers an 
opportunity to evaluate whether and how these benefits accrue across spatial 
scales and the role they play in contributing to the regional economy. 
Understanding how and why benefits accrue differently across alternative 
spatial scales could yield potential solutions for maximizing the total benefit 
flow across all spatial scales.  
 
This project quantifies the economic value of clean water in Lake Champlain 
using household-scale real estate transactions, tourist lodging expenditures 
and a regional economic impact analysis. The development of these models 
was influenced by prior studies, with added emphasis placed on related 
research that was conducted within the region. Further, the availability of data 
to support the modelling effort was also a significant consideration in the 
model estimation phase. Data resources were compiled from a variety of 
sources. Missing data were imputed from existing data when possible and 
strategies for addressing data shortcomings and future data collection efforts 
and priorities were developed. Together with the model outputs, these data 
and analyses should prove useful for facilitating a shared understanding, 
between stakeholders and other interested parties, of biophysical processes 
and socio-economic values which could inform decisions supporting 
sustainable economic development and both recreation and employment 
opportunities. 

 

3 Methodology 

1. Literature review 
The search for valuation literature identified research methods that were 
successfully applied in locations with similar physical and socio-economic 
characteristics, as well as generalized approaches and model parameters that 
have been used for other valuation efforts. To that end, a literature search 
was conducted using multiple alternative search engines, including: Web of 
Science, JSTOR, Elsevier and Google Scholar. More than 40 peer-reviewed 
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publications were identified through this search. A database of relevant 
documents was assembled, including an annotated bibliography, to document 
and justify the modelling approach taken. The database allows for rapid 
search and retrieval of the reviewed literature and data. 
 
Table 1 lists model parameters used in previous hedonic estimations. These 
parameters can be roughly grouped into the following classes: water 
resources (e.g. proximity to, area of and views towards), historic and present-
day nutrient and sediment loads, presence of invasive species and categorical 
variables describing the quality of the lake. An additional table describing 
parcel and structural characteristics, proximity to cultural features and central 
business districts, neighborhood and demographic characteristics and non-
water natural amenities is included in Appendix II.    
 
Table 1: Water-related hedonic parameters documented in the literature database. 

Attribute Studies Using 
Surface area of lake acres Gibbs et al. 2002, Michael et al. 2000, Yoo et al. 

2014,  Boyle et al. 1999, Poor et al. 2007, Zhang 
and Boyle 2010,  Michael et al. 1996 

Deviation from average 
water level at time of sale 

Lansford and Jones 1995 

Categorical variable 
describing lake or beach 

Orr and Pickens 2003 

Distance to public access Orr and Pickens 2003 

Tons of sediment 
loads/lake acre in the 
nearest lake 

Yoo et al. 2014 

Travel time/ travel time 
squared to nearest lake 

Yoo et al. 2014 

Lake Area * Water Quality Gibbs et al. 2002,  Boyle et al. 1999, Poor et al. 
2007, Zhang and Boyle 2010 

Feet of exposed shoreline Loomis and Feldman 2003 

Average depth of lake Bejranonda et al. 1999 

Annual agricultural 
sedimentation 
accumulated / dredged 

Bejranonda et al. 1999 

Water clarity Gibbs et al. 2002, Boyle et al. 1999, Kashian et 
al. 2006,  Poor et al. 2007, Zhang and Boyle 
2010 

Min water clarity for year 
property sold 

Michael et al. 2000, Michael et al. 1996 

Min water clarity for year 
previous to sale 

Michael et al. 2000 

Ten year average of min 
water clarity 

Michael et al. 2000 

Current year clarity * ten 
year average 

Michael et al. 2000 
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Attribute Studies Using 
Current year clarity * ten 
year average adjusted for 
degrading/improving 
condition 

Michael et al. 2000 

Difference between current 
min and historical min 

Michael et al. 2000, Michael et al. 1996 

Percent change in clarity 
over summer months 

Michael et al. 2000 

Total Nitrogen Dodds et al. 2008 

Total phosphorus Dodds et al. 2008 

Eurasian watermilfoil 
percent cover rating/Total 
Aquatic macrophyte 
percent cover rating  

Zhang and Boyle 2010 

Other lake / stream on 
property 

Orr and Pickens 2003 

Lakefront Loomis and Feldman 2003, Lansford and Jones 
1995, Orr and Pickens 2003, Gibbs et al. 2002, 
Michael et al. 2000, Boyle et al. 1999, Kashian et 
al. 2006, Poor et al. 2001, Zhang and Boyle 2010 

Lake view  Loomis and Feldman 2003 

Water source is the lake Boyle et al. 1999, Poor et al. 2001, Zhang and 
Boyle 2010 

Improving / degrading 
water quality trend 

Michael et al. 2000 

* Parameters presented in italics are used as dummy variables, while those 
presented in bold are categorical variables. 

 

2. Data collection and gap analysis 
The data collection effort to support the hedonic price model was largely 
guided by the results of the literature view (see Table 1 and Appendix II). 
These data, focused exclusively on Vermont, were downloaded from a variety 
of public sources, including the Vermont Center for Geographic Information, 
US Census Bureau, US Geological Survey, Vermont Department of Taxes 
and the Vermont Department of Environmental Conservation. Derived data 
were also created from the primary source data using a combination of 
geoprocessing (in ArcGIS) and data conflation and aggregation (using 
Microsoft Access). A complete description of the data processing methods for 
the econometric models is included in Appendix I. 
 
The estimation of the hedonic price model suffered from three primary types 
of data gaps. The first is a result of parcel attribution (e.g. parcel boundaries, 
zoning), structural attribution (e.g. bedrooms, bathrooms, square footage) and 
real estate transactions (e.g. selling price) being managed by different data 
authorities and stored in separate databases with a variety of data structures 
and different reference naming schema (e.g. parcel number, SPAN number, 
physical address) that make conflating the data both challenging and time 
consuming. Data processing was prioritized according to the level of 
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importance in model estimation. Real estate transaction data were geocoded. 
Data detailing structural information was not included due to the amount of 
time required to acquire it from individual town authorities and then join the 
information to existing spatial data and the real estate transaction data. The 
only exception to this was the presence of a garage which was observed 
through a visual inspection of transacted properties using recent aerial 
photography. The second issue is incomplete data. For example, there is not 
complete parcel data for all of the towns in the study area. So, for example, 
instead of a simple spatial query to identify lakefront property, alternative (and 
potentially less accurate) methods were required (i.e. selecting all parcels 
within a specified buffer distance from the Lake boundary). The third type of 
gap is unavailable data. For example, there are no survey data to characterize 
the decision-making process for selecting one property over another, 
including location and accessibility preferences or the influence of socio-
economic, biophysical or natural and cultural resource information. 
 
The tourism expenditure model, also focused on Vermont, was limited by the 
availability of detailed tourism expenditure data. Time series data from the 
Vermont Department of Taxes that quantifies room, meal and alcohol 
expenditures by town were used in place of more detailed information that 
disaggregates total expenditures. From a modelling perspective, 
understanding the motivations (recreational and economic) that guide 
destination and expenditure decisions should lead to a more robust model 
that is better able to inform scenario analysis by relating personal motivations, 
environmental quality and visitation and expenditure decisions. 
 
Data for the input-output model was purchased from a data vendor and 
includes detailed economic and employment data at the county level for both 
New York and Vermont. Additionally, expenditure data was gleaned from a 
report issued by the Agency of Commerce and Community Development 
(Jones, 2015). Both of these datasets represent the best available information 
for the region for developing this type of model. The primary data gap related 
to this model is the availability of survey data with fine resolution expenditure 
information, duration of stay, destination choices and level of influence of the 
Lake on the selection process (versus other natural and cultural amenities 
that bring visitors to the region) that could better inform the development of 
scenarios that support economic development planning. 
 

3. Econometric models 
Hedonic Model 
The hedonic price model was used to identify statistically significant 
determinants of the selling price of a property for towns in close proximity to 
the Lake in the Vermont portion of the basin. A stepwise multiple linear 
regression approach, informed by a thorough review of the literature (see 
Table 1 and Appendix IV for more detail) was used to identify significant 
covariates. Data for the time period between January 2013 and April 2014 
were downloaded from the VT Department of Taxes Property Transfer 
database. The data used in the analysis includes approximately 800 property 
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transactions (for single-family residential) and 70 property transactions (for 
seasonal homes). The data includes the physical address of the property, the 
size of the property and the use type, among other attribution. The physical 
address attribute was used to assign the transaction location on a map 
through the process of geocoding. Once completed, the mapped location of 
transacted properties was used to select relevant data and derive a suite of 
potential model parameters that were hypothesized to influence the selling 
price of a property. The data used in model estimation are separated into 
thematic groupings and are described below. Their summary statistics are 
included in Table 2 (for single-family residential) and Table 4 (for seasonal 
homes).  
 

Single-family residential 
Property parameters 
The parcel area and the assessed property value were included in the VT 
Department of Taxes Property Transfer database. The assessed property 
value was included as an independent variable to account for the lack of 
readily accessible structural data (e.g. number of bedrooms, bathrooms, 
square footage) that are typically included in this type of analysis (Kashian et 
al. 2006, Orr and Pickens 2003, Yoo et al. 2014). Data indicating the 
presence of an attached or detached garage (Loomis and Feldman 2003, 
Bejranonda et al. 1999, Michael et al. 2000, Kashian et al. 2006, Lansford and 
Jones 1995, Michael et al. 1996) was generated using Google Earth. The 
determination regarding the presence and type of garage was made through a 
visual inspection of the property (via the most recently collected aerial 
photography for the region) and assigned a code for one of three classes: no 
garage (0), attached garage (1) or detached garage (2). 
 

Location parameters 
A variety of locational parameters were derived using the Network Analyst 
extension to ArcGIS. Network Analyst allows a user to compute travel cost 
(e.g. measured as time or distance) across a road network. Using a dataset 
that describes employment in the region by sector (i.e. the North American 
Industry Classification System (NAICS)), the location and number of 
employees were used to characterize the accessibility of each transacted 
property in terms of its network distance to clusters of employment types, 
including industrial, service, agricultural and retail establishments. A polygon 
delineating the extent of the road network within 1-, 2.5- and 5-km of each 
transaction point was defined. These bounding polygons were then used to 
tabulate the number of establishments and employees of a specified type 
(e.g. services) that are located within their bounds. Given the relative scarcity 
of large central business districts in Vermont, accessibility to employment and 
commercial activity are used as proxy measures for centers of economic 
activity (Lansford and Jones 1995, Michael et al. 1996, Bejranonda et al. 
1999, Boyle et al. 1999, Michael et al. 2000, Gibbs et al. 2002, Orr and 
Pickens 2003, Poor et al. 2007, Zhang and Boyle 2010). We hypothesize that 
increased proximity to services and retail will have a positive effect on selling 
price while the opposite holds true when considering industrial sites. 
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A 100-m buffer around the lakeshore was computed and then used to identify 
all transacted properties located within this bounding region (Loomis and 
Feldman 2003, Bejranonda et al. 1999, Lansford and Jones 1995). This 
information helped distinguish between properties that are adjacent to the 
Lake (assigned a Lake proximity value of 1) versus those that are more 
distant (assigned a Lake proximity value of 0) (Loomis and Feldman 2003, 
Lansford and Jones 1995, Orr and Pickens 2003, Gibbs et al. 2002, Michael 
et al. 2000, Boyle et al. 1999, Kashian et al. 2006, Poor et al. 2001, Zhang 
and Boyle 2010). Additionally, the county of each location was assigned to 
each transaction point to test for potential county-level effects (Yoo et al. 
2014). Based on this information, a dummy variable was created to indicate 
whether a property was located inside (assigned a value of 1) or outside 
(assigned a value of 0) Chittenden County.  
 

Demographic parameters 
Data from the 2013 American Community Survey was downloaded at the 
Block Group scale from AmericanFactfinder (http://factfinder.census.gov). 
Median household income (Boatwright et al. 2013, Yoo et al. 2014) and 
percent vacant housing units were expected to have positive and negative 
effects, respectively. Each transacted property is coded according to the 
Block Group within which it resides and the census data values are assigned 
accordingly. 
 
In addition, the E911 (emergency services) data was used to compute the 
residential density (Michael et al. 1996, Bejranonda et al. 1999, Michael et al. 
2000, Poor et al. 2001,  Gibbs et al. 2002, Boatwright et al. 2013, Yoo et al. 
2014) within 1-km of a transacted property. The E911 data were accessed via 
the Vermont Center for Geographic Information (VCGI) online data portal 
(http://vcgi.vermont.gov/). This data is coded according to use type (e.g. 
residential, commercial), enabling the selection of residential properties for 
use in the development density computations. The ArcGIS Spatial Analyst 
Point Density Tool was used the E911 residential property locations to derive 
a dataset that represents the housing density (Boatwright et al. 2013) over a 
continuous surface for the entire study area. A 1-km buffer was delineated for 
each real estate transaction point and the ArcGIS Spatial Analyst Zonal 
Statistics Tool computed the average housing density within each buffered 
region. Given the relatively low-density development patterns observed 
throughout the state, it was expected that a higher development density would 
translate to a lower transaction price. 
 
Landscape and environmental parameters 
In addition to Lake proximity (described above), a parameter defining the 
visibility of the Lake (Lansford and Jones 1995,  Orr and Pickens 2003) from 
each transaction point was computed using the ArcGIS Spatial Analyst 
Viewshed tool. This tool requires a viewpoint location (i.e. the transaction 
point) and an elevation surface (i.e. a Digital Elevation Model (DEM)) over 
which the views are to be computed. The USGS SRTM 10-m DEM was 

http://factfinder.census.gov/
http://vcgi.vermont.gov/
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downloaded from The National Map (http://nationalmap.gov/) and used as the 
elevation surface in the analysis.  
 
Ideally the view from the entire parcel would be considered. However, parcel 
data is not available for all of the jurisdictions within the study area. As a 
result, we computed the viewshed from the location of the E911 points that 
are coincident with the real estate transactions. These points represent the 
approximate location of the building footprint within the parcel. The viewshed 
was computed from the surface elevation at each transaction point over a 30-
km radius. Because the Lake surface was the landscape feature of interest, 
no vertical offset was assigned to the Lake level. Finally, the default value for 
the earth curvature correction factor was applied to limit the visibility of more 
distant locations. 
 
A viewshed analysis yields a data layer with two values 0 (location is not 
visible) and 1 (location is visible). Once the viewshed of a property was 
computed the result was intersected with the Lake boundary to determine the 
proportion of a property’s viewshed that is comprised of the Lake. The 
expectation here is that, all things being equal, properties with greater Lake 
visibility are expected to have a higher selling price. 
 
Finally, because the primary concern of this portion of the study is the effect of 
Lake water quality on property valuation, a number of alternative 
representations of water quality were explored, including Secchi depth (m) 
(Boyle et al. 1999, Gibbs et al. 2002, Kashian et al. 2006,  Poor et al. 2007, 
Zhang and Boyle 2010), net phytoplankton density (cells/L), net zooplankton 
density (cells/L), Total Nitrogen (μg/L), Total Phosphorous (μg/L), water 
temperature (°C) and chlorophyll-A (mg/L). Data were downloaded from the 
Lake Champlain Long-term Water Quality and Biological Monitoring Project 
(http://www.watershedmanagement.vt.gov/lakes/htm/lp_longterm.htm). The 
monitoring program includes 15 stations scattered throughout the Lake, as 
well as 22 stations located at tributary mouths around the Lake. Data 
collection under this program began in 1992, and data has consistently been 
collected at each station through the present day (with the exception of 
stations that have been added since the monitoring program began). 
 
Data from May through September for the years 2010 – 2014 were acquired. 
Data were grouped according to the month in which they were collected and a 
monthly average value across all years for each of the potential parameters 
was computed. Ultimately the August average Secchi disk depth value was 
selected for inclusion in the model. This Secchi disk depth factor was selected 
because of its connection to not only Lake water quality, but also to the easily 
understood nature of the parameter by a non-technical audience, as well as 
its impacts on recreation (Egan et al, 2009) and quality of life. While nitrogen 
or phosphorous loads have a more direct relationship with water quality, 
changes in these values typically require scientific instrumentation to quantify 
as they are not discernible to the naked eye, and therefore less apparent to a 
current or prospective property owner in the absence of an extreme event 

http://nationalmap.gov/
http://www.watershedmanagement.vt.gov/lakes/htm/lp_longterm.htm
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(e.g. algal bloom) (Leggett and Bockstael, 2000). The month of August was 
selected because it had the second most real estate transactions of any 
month in the year and because it corresponds with the typical timing of 
summer algal blooms and other water clarity problems. Each of the transacted 
properties was assigned the value of the nearest long-term monitoring station 
and data values were ascribed accordingly to reflect differences in water 
clarity throughout the Lake. 
 
Summary statistics for the selected model parameters are presented in Table 
2. Mean selling price for all houses in the study area is approximately 
$300,000. Most properties are located outside the 100-m Lake buffer. Slightly 
more than half of the properties are located inside Chittenden County and 
feature an attached garage. The mean Secchi disk depth reading for the 
previous five years is nearly 4.4-m, and the mean percent of Lake visibility 
within the viewshed of a transacted location is more than 10%. 
 

Results 
The result of the OLS regression for single-family residential properties is 
listed in Table 3 below. The model explains approximately 59% of the 
variation in the dependent variable. A log-level model approach (Bin, O. and 
J. Czajkowski, 2013; Cropper, M. L., L. B. Deck, and K. E. McConnell, 1988) 
was applied, meaning that the dependent variable (Selling Price) is log-
transformed (to deal with the right-skewed makeup of the transaction data) 
(see Equation 1 below). All of the independent variables maintain their original 
form. The result of this estimation is interpreted as a one-unit change in x 

results in a 100*β1 percent change in y. 
 

Equation 1: ln(𝑦) =  𝛽0 +  𝛽1(𝑥) +  𝜀  

 

While the primary concern here relates to the effect of the Lake on selling 
price, the coefficients of structural, locational and demographic covariates 
behaved as expected. The assessed property value, parcel size, number of 
service and retail establishments in close proximity, locations within 
Chittenden County and the inclusion of a garage (attached or detached) are 
all positive determinants of price, while the number of industrial facilities within 
5-km of a property, residential density within 1-km of a property and the 
percentage of vacant housing units in the block group are all negative 
determinants of price. Of these model parameters, a location within 
Chittenden County has the greatest positive effect on overall property value 
(0.269), followed by the presence of an attached garage (0.143) and a 
detached garage (0.101). 
 

These results also highlight the role of the Lake in accentuating the value of 
properties within the region. First, given two properties one located within 100-
m of the Lake and the other outside the 100-m buffer, the former is expected 
to bring a selling price nearly 30% more than the latter, all else being equal. A 
one-unit increase in lake visibility would be expected to bring almost a 44% 
premium on the selling price. Finally, and of particular relevance to this 
investigation, water clarity is also important to homebuyers. A one-meter 
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increase in average August Secchi depth (over a 5-year period) would be 
expected to result in a nearly 3% increase in the selling price of a single family 
residence, all else being equal. 
Table 2: Summary statistics for single-family residential homes in Vermont towns near 
Lake Champlain.  

Parameter* Mean Std. Dev. Min Max 

Selling Price ($) 303,954.1 161222.1 100,000 959,500 

Parcel Size (acres) 101.1053 119.6864 1 441 

Industrial facilities w/in 5-km 62.50771 83.46671 0 284 

Services w/in 1-km 41.92408 118.6462 0 756 

Retail outlets w/in 5-km 121.1103 184.2672 0 532 

Is w/in 100-m of Lake 
Champlain 0.098225 0.297795 0 1 

Lake Visibility 0.10238 0.125665 0 0.575038 

Average August Secchi 
Depth (m) 4.373148 1.30664 1.540217 5.18942 

Garage Code 

    1 - Attached Garage 0.536095 0.498991 0 1 

2 - Detached Garage 0.263905 0.44101 0 1 

Is in Chittenden County 0.570749 0.495264 0 1 

Assessed Property Value 933.5337 543.8839 1 1957 

Housing density w/in 1-km 201.7777 232.9954 1.183507 862.0738 

* Parameters presented in italics are used as dummy variables, while those 
presented in bold italics are categorical variables. 

 
Seasonal Home 
Property parameters 
Unlike the model for single-family residential, the assessed value of a property 
was not found to be a statistically significant explanatory variable for seasonal 
dwellings. Because the assessed value parameter was used to account for 
the structural characteristics of the property, and structural parameters are 
frequently featured in hedonic models, an alternative was developed by 
digitizing building footprints for transacted properties using Google Earth. The 
City of Burlington was the only jurisdiction within the study area that had this 
data available in digital format (ArcGIS shapefile). Footprints digitized in 
Google Earth were merged with those from the City of Burlington to create a 
unified data set. It is assumed that camps are single-story structures and that 
the footprint data is an accurate predictor of the size of the structure. The 
remaining property parameters used in the estimation were derived from the 
same data sources described in the single-family dwelling section above. 
 
Location parameters 
Two additional locational parameters (not used in the single-family model) 
were developed for use in the camp model estimation. The first used the 
ArcGIS Network Analyst Extension to compute the driving distance to the 
nearest highway interchange. The network distance uses a shortest path 
algorithm to compute the least cost path (measured as a distance in m) from a 
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property to the closest highway interchange. Additionally, the linear distance 
between individual properties and the nearest conserved land was computed. 
It was assumed that people spending time at their camp require reasonable 
accessibility to the highway (to minimize travel time between their primary and 
secondary residences) and conserved land while expressing a desire to be 
outside more developed areas (e.g. housing density factor). 
 
Table 3: Model coefficients for single family residential dwellings. 

Parameter Coefficient Std. Err. t-value 
Constant 11.6257*** 0.0529 219.9 

Parcel Size (acres) 0.0006143*** 0.0001 5.28 

Industrial facilities w/in 5-km -0.001568* 0.0009 -1.79 

Services w/in 1-km  0.0003828*** 0.0001 2.89 

Retail outlets w/in 5-km 0.0010464*** 0.0004 2.86 

Is w/in 100-m of Lake 
Champlain 

0.2975233*** 0.0414 7.18 

Lake Visibility 0.4361667*** 0.105 4.15 

Average August Secchi Depth 0.0298202** 0.0121 2.47 

Garage Code    

1 – Attached garage 0.1425714*** 0.0303 4.71 

2 – Detached garage 0.1005899*** 0.0329 3.06 

Is in Chittenden County 0.2691349*** 0.0378 7.13 

Assessed Property Value 0.0003978*** 2E-05 16.15 

Housing density w/in 1-km -0.000276*** 9E-05 -3.09 

Observations 806   

F(14, 791) 93.62   

Prob > F 0   

R-squared 0.5862   
* 
Denotes significance at the 0.10 confidence level. 

** 
Denotes significance at the 0.05 confidence level. 

*** 
Denotes significance at the 0.01 confidence level. 

Parameters presented in italics are used as dummy variables, while those presented in bold 
italics are categorical variables. 

 

Results 
Table 4 details the summary statistics for the parameters selected for 
inclusion in the hedonic model specification. The mean selling price of a 
seasonal home is lower than a full-time single family residence, even though 
the majority of the transactions used in this stage of the analysis are located 
within 100-m of Lake Champlain. The low mean housing density within 1-km 
reveals a preference for lower-density development than one might consider 
when purchasing a full-time residence. 
 
The result of the OLS regression for camp properties is listed in Table 5. The 
model explains nearly 70% of the variation in the selling price of camps on or 
near Lake Champlain. Although the coefficient of variation is higher in this 
model compared to the single-family residential properties, there is a greater 
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degree of variability in the level of significance of the model parameters 
(which may be attributed to the smaller sample size used in model 
estimation). Once again a log-level approach was applied for model  
 
Table 4: Summary statistics for camps in Vermont towns near Lake Champlain. 

Parameter Mean Std. Dev. Min Max 
Selling Price 264741.5 235077.6 12936 1051000 

Parcel Size (acres) 91.30882 123.6028 1 415 

Building Footprint (m) 154.9033 124.8854 34.16978 587.8153 

Is w/in 100-m of Lake 
Champlain 

0.823529 0.384054 0 1 

Average August Secchi Depth 4.017165 1.261142 1.540217 5.18942 

Housing density w/in 1-km 28.59574 15.34159 4.457757 85.98135 

Lake Visibility 0.061474 0.057693 0 0.279914 

Driving Distance to Highway 
Interchange (m) 

33.78455 17.91894 8.739854 88.82067 

Driving Distance to 
Conserved Land (m) 

1337.311 886.1205 49.45374 3575.006 

* Parameters presented in italics are used as dummy variables, while those 
presented in bold italics are categorical variables. 
 
Table 5: Model coefficients for a camp on or near Lake Champlain. 

Parameter Coefficient Std. Err. t-value 
Constant 10.46129*** 0.4087625 25.59 

Parcel Size -0.0017204** 0.0007373 -2.33 

Building footprint size (sq m) 0.0036444*** 0.0007116 5.12 

Is w/in 100-m of Lake Champlain 0.4927785** 0.2383224 2.07 

Average August Secchi Depth 
(m) 

0.3670227*** 0.0631481 5.81 

Housing density w/in 1-km -0.01277** 0.0058238 -2.19 

Lake Visibility 5.703466*** 1.465948 3.89 

Driving Distance To Highway 
Interchange (m) 

-0.0105241* 0.0062328 -1.69 

Distance to Conserved Land (m) -0.0001974** 0.0000978 -2.02 

Observations 64     

F(8, 55) 17.02     

Prob > F 0     

R-squared 0.6909     
* Denotes significance at the 0.10 confidence level. 
** Denotes significance at the 0.05 confidence level. 
*** Denotes significance at the 0.01 confidence level. 
Parameters presented in italics are used as dummy variables, while those presented in bold 
italics are categorical variables. 
 

estimation, meaning that the dependent variable (Selling Price) is log-transformed. 
All of the independent variables maintain their original form. Unlike the single family 
residential model results, the parameters with the greatest effect on the selling price 



An Assessment of the Economic Value of Clean Water in Lake Champlain  

 

 

 Page 19 of 51 

 

of a seasonal property are all lake-related, including: views of the Lake, the proximity 
to the Lake and the 5-year average August Secchi disk depth measurement (in order 
of decreasing importance). Further, purchasers of seasonal homes positively value 
building size, while considering larger parcels, longer distances to a highway 
interchange or conserved land and higher household density as features that detract 
from the overall selling price. 

 
Sub-Regional Expenditure Model 
While the link between water quality and lake-based tourism and second 
home expenditures is obvious to many, in the absence of targeted surveys it's 
difficult to directly measure. This is particularly true in more diversified 
economies like Chittenden or Clinton Counties, or economies like Essex 
County with a predominance of non-Lake related summer tourism. Therefore, 
a more detailed case study of lakeside communities was pursued. This 
analysis used meals and rooms receipts data for six towns between May and 
September. The communities chosen included the five main lakeside towns in 
Grand Isle County (Alburgh, Grand Isle, Isle La Motte, North Hero, and South 
Hero), and one lakeside town in Franklin County (Swanton). Each of these 
towns had complete data for monthly room receipts for 2010 through 2014, as 
well as water quality data at nearby lake sampling points. St. Albans Town 
and City were considered, but lacked complete room receipt data because 
there were fewer reporting entities than required to meet thresholds for public 
dissemination of the data. Summer tourism in these communities is 
particularly dependent on Lake Champlain, whereas more diverse tourism 
economies in Chittenden and Addison Counties makes any water quality 
impact difficult to distinguish from other tourism draws (e.g. hiking and cycling 
in the Green Mountains).  
 

The general hypothesis regressed monthly room receipts data (adjusted for 
inflation) as the dependent variable against Secchi disk depth data (the 
independent variable). Models were estimated for each summer month by 
pooling data from 2010 through 2014 across the six lakeside towns. Table 6 
summarizes regression results for each month. There is insignificant 
correlation between Secchi values and room receipts for the May, June, and 
September models. However, the July and August models show evidence that 
room receipts depend on water quality at the height of the summer tourism 
season during the months when algal blooms and other water clarity problems 
have been most present. For example, between 2012 and 2014, St. Albans 
Bay Park and Red Rocks Beach were closed more than ten times and nine 
times, respectively, due to either an excess of e coli or the presence of toxic 
blue-green algae (Lake Champlain Basin Program, 2015). 
 
Figure 1 highlights the August model results, the strongest evidence of a 
water quality impact on tourism with an estimated $71,721 impact on room 
receipts per meter of water clarity decline across the six lakeside communities 
(in 2014 dollars). This represents 6.7% of the five-year average of August 
room receipts for the five towns with complete yearly data (i.e. not including 
Grand Isle). A two-meter loss – well within the change from Alburgh or Isle La 
Motte conditions to Swanton conditions – would result in a 13.4% decrease in 
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lodging revenues. If this percent loss is extended to other tourism sectors, the 
estimated impact grows from tens of thousands to hundreds of thousands, 
just for the month of August, and just for these six lakeside towns. If even a 
portion of this percentage loss were translatable to the broader, $300 million 
lake-based tourism economy summarized in Table 10, the water quality 
impact on tourism revenues would likely be in the millions. 
 
Table 6: Regression results for monthly rooms expenditures and average August 
Secchi depth. 

Model Intercept Coefficient t-statistic p-value R-squared 

May 14,012 8,541 1.68 0.144 0.320 

June 137,681 -8,308 -0.84 0.412 0.040 

July 25,849 42,179 2.27 0.031 0.156 

August -36,733 71,721 3.39 0.002 0.324 

September 4,466 23,707 1.50 0.163 0.169 

 
 

 
Figure 1: August room receipts plotted against Secchi disk depth, 2010-2014. 

One problematic aspect of the data used in the regression analysis presented 
in Table 6 is that it is not normalized by the relative size of the lodging sector 
within each of the six towns. Data in Figure 1 represents two clusters of room 
receipts: 1) North and South Hero feature relatively high total room receipts 
for August, while 2) Swanton, Alburgh, Isle La Motte and Grand Isle are 
grouped along a lower room receipt axis. In order to normalize the room 
receipts data, the total number of lodging units in each of the six towns was 
estimated by browsing Chambers of Commerce, Google Maps and general 
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lodging inquiries. This information was supplemented by referencing individual 
business web pages for room totals. Estimates for number of units for each 
town (as of August 2015) was then divided into monthly room receipts. Figure 
2 plots August room receipts per unit against Secchi depth data, with each of 
the six town clusters highlighted again.  

 

 
Figure 2: August room receipts per unit plotted against Secchi disk depth, 2010-2014. 

South Hero still stands out with relatively high room receipts per lodging unit 
and high water clarity; however, the other five towns now lie along a water 
quality impact gradient within a more narrow range of lodging expenditures. 
This August model has an R-squared goodness-of-fit statistic of 0.510, and a 
strongly significant (p<0.0000) Secchi coefficient of $2,303 loss per average 
lodging unit per meter of water clarity decline in each town. A July model also 
demonstrates high correlation, with an R-squared statistic of 0.303 and a 
significant (p<0.002) Secchi coefficient of $1,545. Extrapolating the August 
model coefficient to an estimated average of 48 lodging units per town 
(including bed and breakfast, motel/hotel rooms, cottages, and cabins), the 
impact of a one-meter decline in water quality translates into a loss of 
$110,544 for the month of August. This amounts to approximately 10.3% of 
average August room receipts for the five towns with complete yearly data for 
a one-meter loss of lake clarity, or 28% for a two-meter loss. 
 

4. IMPLAN SAM model 
The regional economic model was built using the 2013 IMPLAN database for 
Vermont and New York, a system of economic accounts based on national 
input-output tables produced by the Bureau of Economic Analysis and tailored 
for county-level employment, income, household characteristics and industry 
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make-up (see www.implan.com). To focus on tourism and second-home 
expenditures most directly impacted by water quality, the regional economy 
was defined as the four Vermont and two New York counties that make up the 
majority of the Lake Champlain shoreline (see Figure 3). Econometric 
analysis of tourism expenditures and water quality data in six lakeside 
communities with a predominance of summer, lake-based tourism activities 
enabled a sub-regional impact analysis.  
 

 
Figure 3: Shoreline counties within the larger basin included in Lake Champlain 
economy model. 

In Vermont, the main shoreline counties include Addison, Chittenden, Franklin 
and Grand Isle, together accounting for 45% of 2013 Gross State Product 
(GSP), 43% of employment and 40% of the state’s population (Table 7). 
Chittenden is the largest and most populated county economy in Vermont, 
centered around the City of Burlington on the shores of the main lake. Grand 
Isle County, VT is at the opposite end of the spectrum with one of the smallest 
employment bases (more closely representing Essex County in northeastern 
Vermont). These four counties account for more than 24% of the land area of 
Vermont, but make up approximately 48% of the Vermont portion of the Lake 
Champlain Basin (with all but a small section of Addison County entirely within 
the Basin).  
 
On the New York side, the main shoreline counties include Clinton and Essex, 
together accounting for a very small portion of the state's 2013 gross state 
product (0.41%), employment (0.54%) and population (0.61%). The largest 

http://www.implan.com/
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city is Plattsburgh, northwest of Burlington and connected by ferry to Grand 
Isle, Vermont. The low average household incomes are more characteristic of 
rural Vermont counties (e.g. Addison), than the New York state average. 
Aside from the city of Plattsburgh, both are very rural counties. Essex County 
has one of the lowest population densities in the state, second only to 
Hamilton County to the west, and is located entirely within the Adirondack 
Park. 
 
Table 7: Lake Champlain Shoreline Economy Model, 2013 

Geography 
GSP 

(billion $) 

Employment 
(Employment 

Diversity*) 
Average HH 
Income ($) Population 

Land Area 
(sq. miles) 

Vermont 29.760 425,161 (0.76) 106,305 626,630 9,249 

Addison 1.501 24,090 (0.70) 99,577 36,791 770 

Chittenden 10.006 131,509 (0.74) 117,477 159,515 539 

Franklin 1.754 24,492 (0.70) 112,533 48,294 637 

Grand Isle 0.146 2,424 (0.66) 115,790 6,987 83 

 
New York 

 
1,303.874 

 
11,641,545 (0.74) 

 
141,763 

 
19,651,130 

 
47,224 

Clinton 3.587 41,570 (0.70) 92,485 81,591 1,039 

Essex 1.749 21,298 (0.68) 88,524 38,762 1,797 

 
Total 

 
18.743 

 
245,383 (---) 

 
--- 

 
371,940 

 
4,865 

* Shannon-Weaver diversity index 
 

The six-county region is predominately a service sector economy, with 
significant employment in professional services, retail trade and the health 
care sector. Table 8 highlights the top ten sectors by employment (for each 
county) by aggregating 3-digit North American Industry Classification System 
(NAICS) codes into region-specific industry groupings. The groupings are 
similar to a standard 2-digit NAICS aggregation, which includes 20 sectors in 
IMPLAN. The custom aggregation provides more detail in the agricultural, 
service, and government sectors, resulting in 53 total sectors for the model 
(see Appendix II for more information). The left-hand column of Table 8 lists 
the top ten sectors for the region as a whole, with full-time equivalent 
employees and sector ranking listed for each of the six counties. Analysis of 
the ten sectors by employment accounts for 70-74% of the total employment 
for each county. The county economies are more similar than different, with 
the top seven sectors for the region all represented in the top ten for each 
county. Locations with evident differences include employment in state and 
local government outside of education in the New York counties due to prison 
and state agency jobs. Franklin, Grand Isle and Clinton Counties each border 
Quebec, and thus include transportation and warehousing in their top ten. 
Both Chittenden and Essex counties have the aggregated arts and recreation 
sector in their top ten, while the influence of the dairy industry stands out in 
both Addison and Grand Isle counties in Vermont. The county economy with 
the most tourism-related sectors is Essex with retail trade (1), restaurants (5), 
hotels & accommodations (9) and arts & recreation (10) all in the top ten. 
However, much of this is concentrated away from Lake Champlain in the 
interior of the Adirondack Park near Lake Placid. 
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Table 8: Top 10 Economic Sectors by Employment, Six-County and Individual County 
Models, Custom Aggregation, 2013. 

Economic Sector 

Vermont New York 

Addison Chittenden Franklin Grand Isle Clinton Essex 

(Rank by County) Sector Employment (County Model Rank) 

(1) Professional 
Services 2,413 (2) 20,872 (1) 2,400 (2) 342 (1) 3,382 (3) 1,450 (7) 

(2) Retail Trade 2,453 (1) 13,902 (3) 2,778 (1) 283 (3) 5,831 (1) 2,217 (1) 

(3) Health Care 2,122 (4) 14,022 (2) 2,337 (3)  4,855 (2) 1,873 (3) 

(4) State & local 
gov't payroll, 
education 1,324 (7) 9,227 (5) 2,130 (4) 76 (10) 2,774 (6) 1,091 (8) 

(5) Finance, 
insurance & real 
estate 1,562 (6) 9,254 (4) 1,211 (7) 112 (7) 2,380 (7) 1,649 (4) 

(6) Restaurants & 
drinking est. 1,055 (9) 8,609 (6) 1,213 (6) 118 (6) 3,052 (5) 1,522 (5) 

(7) Construction, 
mainten. & repair 1,745 (5) 6,492 (7) 1,518 (5) 289 (2) 1,821 (9) 1,507 (6) 

(8) State & local 
gov't payroll, non-
educ.     3,310 (4) 2,181 (2) 

(9) Family & 
community 
services 1,181 (8) 4,877 (8)     

(10) Wholesale 
trade  4,034 (9)   2,026 (8)  

(11) Education 2,208 (3)   96 (8)   

(12) Arts & 
recreation  3,883 (10)    940 (10) 

(13) 
Transportation & 
warehousing   

1,113 
(10) 158 (5) 1,298 (10)  

(14) Federal gov't 
payroll   1,201 (9)    

(18) Food & drink 
manufacturing   1,201 (8)    

(21) Hotels & 
accommodations      1,075 (9) 

(22) Animal 
production 818 (10)   91 (9)   

(23) State & local 
gov't enterprises    190 (4)   

% of Total 
County 

Employment 70.1% 72.4% 69.8% 72.4% 73.9% 72.8% 

 

Table 9 lists Vermont estimates of 2013 and 2003 visitor spending in sectors 
considered a major part of the tourism economy in the "Benchmark Study of 
the Impact of Visitor Spending on the Vermont Economy" for 2013 (Jones, 
2015). Expenditures include day visitors and drive through traffic (7.3 million 
visitors); overnight visitors staying with friends and family (1.9 million) or using 
campgrounds (300,000) and commercial lodging (1.6 million); and overnight 
visitors using second homes (1.7 million visitors). The Benchmark Study 
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provides these estimates in nominal dollars, showing a 42.3% increase in 
tourism spending over the 10-year period. However, when adjusted for 
inflation, spending has increased from $2.25 to $2.49 billion in 2013 dollars, or 
just 10.7%.  
 
Table 9: Estimates of Vermont Tourist Expenditures, 2013 and 2003 

Expenditure 2013 (million $) 2003 (million $) 

Day and Overnight Tourism 
  Lodging 430 320 

Restaurants & bars 400 275 

Gasoline sales 150 65 

Groceries & convenience 
stores 150 100 

Other retail sales 220 150 

Recreation & entertainment 300 200 

Travel expenses 140 100 

 Automotive rentals 30 25 

Second Home Expenses 
  Construction & renovation 200 150 

Property taxes 240 140 

Utilities & fuel 125 80 

Maintenance, insurance & 
management 105 70 

TOTAL 2,490 1,750 

 

Of the nearly $2.5 billion estimated spending by Vermont tourists in 2013, the 
Agency of Commerce and Community Development estimates that 
approximately $300 million was spent "in and around Lake Champlain" 
(Moulton and Markowitz, 2015).Assuming Vermont-wide sectoral shares of 
tourism expenditures (based on Jones, 2015), Table 10 summarizes a 
modelling scenario for $300 million of tourism-related expenditures in the four 
Vermont counties for a disaggregated version of the shoreline economy 
model.  
 

Taken together, these Vermont tourism-related expenditures attributed to 
Lake Champlain account for about 2.2% of the four-county gross regional 
product. However, this spending has an important multiplier effect in the 
region. IMPLAN derives regionalized multipliers by adjusting sector-to-sector 
relationships based on state level data to estimate both the indirect and 
induced effects from each dollar spent. In the Lake Champlain model, each 
dollar of labor income required within lake-related tourist sectors will generate 
an additional $0.57 in labor income through indirect industry inputs and 
induced impacts from additional spending of households. Similarly, each 
dollar of value-added (taxes, property income, profits) income generated in 
tourism-related sectors generates another $0.62. In terms of employment, 
every new job related to the lake tourism economy creates an additional 0.4 
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jobs to support indirect and induced activities. Table 11 summarizes this total 
economic impact across the four Vermont counties. The direct effect includes 
the initial round of spending highlighted in Table 10, less the property tax 
expenditures (calculated separately in IMPLAN as a value-added output). The 
indirect effect comes from all the necessary inputs from across the economy 
needed to support the tourism expenditures. The induced effect arises from 
regional spending from labor income. 
 
Table 10: Inferred Tourism Spending in Vermont Lake Champlain Counties, 2013. 

Expenditure 
IMPLAN 
Sector # 

% of VT 
Tourism 

Spending 

Inferred 4-
County 

Spending 
(million $) 

Day and Overnight Tourism    

Lodging 499 17.3% 51.807 

Restaurants & bars 501 16.1% 48.193 

Gasoline sales 402 6.0% 18.072 

Groceries & convenience stores 400 6.0% 18.072 

Other retail sales 405 8.8% 26.506 

Recreation & entertainment 496 12.0% 36.145 

Travel expenses 412 5.6% 16.867 

Automotive rentals 442 1.2% 3.614 

Second home expenses    

Construction & renovation 59 8.0% 24.096 

Property taxes 
 

9.6% 28.916 

Utilities & fuel 49 5.0% 15.060 

Maintenance, insurance & 
management 440 4.2% 12.651 

TOTAL 
 

100.0% 300.000 

 
Table 11: Economic Impact Analysis of Vermont Lake Tourism Spending in Four-
County Model, 2013. 

Effect 
Type Employment 

Labor 
Income 

Value  
Added Output 

Direct 2,818.8 $78,060,759 $124,907,998 $222,397,943 

Indirect 468.3 $19,934,026 $34,747,850 $62,605,641 

Induced 602.8 $24,830,150 $42,071,180 $71,343,980 

Total Effect 3,889.9 $122,824,935 $201,727,027 $356,347,563 

 

Table 12 highlights the top ten sectors by employment impacted by tourism 
spending in the four-county region. Non-tourism sectors such as hospitals that 
were not part of the direct spending make the top ten because of the induced 
spending from labor income. Also, sectors such as real estate appear due to 
the indirect effects from second home expenditures. 
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Table 12: Top Ten Employment Impacts of Vermont Lake Tourism Spending, 2013. 

Description 
IMPLAN 
Sector Employment 

Labor 
Income 

Value 
Added Output 

Restaurants 501 1,044.5  $23,108,900  $26,118,392   $50,318,104  

Hotels and 
motels 499 552.4  $16,643,463   $32,808,759   $51,944,431  

Amusement & 
recreation  496 549.8  $11,738,862   $22,033,182   $36,449,977  

Passenger 
transportation 412 257.7  $7,960,451   $9,751,883   $17,232,167  

Residential 
Construction 59 167.3  $9,280,381   $10,696,033   $24,096,000  

Real estate 440 133.4  $3,420,671   $21,363,392   $26,012,401  

Retail - General 
merchandise 405 118.8  $3,384,789   $4,989,671   $8,158,037  

Retail - Food & 
beverage  400 105.6  $2,990,761   $4,068,955   $6,532,853  

Hospitals 482 39.0  $2,769,695   $3,142,183   $5,454,535  

Retail - 
Gasoline stores 402 37.4  $1,417,161   $1,781,058   $2,790,054  

  
 

5. Scenario analysis: The IMPLAN model was used to analyse scenarios 
examining the relationship between visitation rates, visitor expenditures and 
regional economic effects. The hedonic model, on the other hand, was used 
to analyse the relationship between Total Phosphorous and Secchi Depth 
measurements to estimate changes in water clarity resulting from 
hypothesized changes in nutrient loading. This information was used to 
estimate changes in property values in relation to changes in water quality 

 

IMPLAN SAM Model 
Regression results from the tourism expenditure model provided the basis for 
a broader assessment of the vulnerability of regional tourism activity to water 
quality conditions within the Lake. Referring to the estimated $300 million in 
2013 tourism expenditures tied to Lake Champlain, Vermont's Secretary of 
Commerce and Economic Development together with the Secretary of Natural 
Resources commented earlier this year state that, "Nutrient pollution and the 
resulting cyano-bacteria outbreaks (or blue-green algae blooms) present a 
serious threat to all of this lake-based economic activity".1 Scenario analysis 
using the 4-county IMPLAN model, together with coefficient estimates from 
the 6-town room receipts model, was conducted to assess the degree of this 
threat to the Lake Champlain tourism economy. 
 
For example, the regression of Secchi disk depth against room receipt data 
normalized by the number of units per town (Figure 2) showed an estimated 
impact of lodging revenue ranging between 6.5% in July to 10.3% in August 
from a one-meter loss of water clarity. Assuming the bulk of the $300 million 

                                                
1 April 15, 2015 Rutland Herald editorial. See footnote 1. 
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in lake-related tourist expenditures occurs in the summer, peaking in July and 
August, suppose that 25%, or $75 million per month, is spent in the four 
Vermont lake counties in each of the two most impacted months. The total 
impact for July and August would be $12.6 million. This represents 
approximately 4.6% of the direct impact used to simulate the IMPLAN tourism 
scenario summarized in Table 10 and Table 11. Propagated across the 
regional economy, this translates into a total employment loss in the four 
Vermont counties of 195 full-time equivalent jobs. In addition, the loss of labor 
and other value-added income is estimated at $16.8 million. 
 
IMPLAN models can also be used to simulate the estimated impacts of 
specific events, especially when survey data is available. In the case of 
tourism directly related to Lake Champlain, these might include lakeside 
festivals (e.g. Jazz Fest, Burlington Beer Festival), regattas and fishing 
tournaments. For example, a recent IMPLAN study commissioned by the 
North Country Chamber of Commerce (Read, 2012) investigated the 
economic impact of the 2012 summer series of Lake Champlain Pro Bass 
Fishing Tournaments. The model was built for Clinton County using the 2009 
IMPLAN database. Data from a participant survey was used to estimate direct 
expenditures on lodging, food, fuel, and entertainment related to anglers’ 
direct trips totalling $1.14 million during the five tournaments, with an 
additional $1.4 million spent on scouting trips to the region. Combined with 
spending by tour organizers, the bass tournaments generate 27.2 direct jobs 
and an additional 7.3 indirect and induced jobs (Read, 2012). An estimated 
$74,285 in labor income is generated, and a total of $2,742,581 in gross 
regional product (Read, 2012). 
 
Hedonic Model 
Regression analysis was used to test the relationship between the natural log 
of both Secchi disk depth data (m) and Total Phosphorous (μg/L). More than 
630 observations from 1992 – 2014 were used in the analysis. The mean 
value of all Total Phosphorous observations is 24.167 μg/L. Results indicate a 
strong relationship between the two factors (Table 13, Figure 4) with a one-
percent (μg/L) increase in Total Phosphorous yielding a corresponding Secchi 
disk decrease of 0.88%. These results were used as the basis of scenario 
analysis for the hedonic models. 

 
Table 13: Regression results for analysis of Total Phosphorous and Secchi disk depth 
data. 

Intercept Coefficient t-statistic p-value R-squared 

3.967 -0.88378 -43.248 0.000 0.748 
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Figure 4: Scatterplot with fitted line for the natural log of Total Phosphorous (μg/L) and 
the natural log of the Secchi disk depth (m) data. 

Required change in Phosphorous load under revised TMDL 
In a November 2014 meeting, the US Environmental Protection Agency (EPA) 
estimated that a 34% reduction in phosphorous loading would be required to 
meet the target load for the State of Vermont (EPA, 2014). A 34% reduction to 
the mean Total Phosphorous observations would yield a revised mean Total 
Phosphorous value of 15.950 μg/L (for an absolute decrease of 8.22 μg/L). 
Using the regression results described above (Table 13), this translates to 
1.67-m increase in Secchi disk depth, and approximately $15,200 price 
increase for the selling price of the average single family residential dwelling 
within the study area (see Table 2). 
 

Estimated impacts of climate change on Phosphorous loading within the 
basin 
TetraTech used the Soil and Water Assessment Tool (SWAT) to estimate 
potential change in phosphorous loading throughout the basin as a result of 
climate change (TetraTech, 2013). They examined six different climate 
scenarios extending through 2040 – 2070 as part of their analysis. Taking the 
average of the six scenarios, the annual phosphorous load for the entire Lake 
Champlain basin is expected to increase by 29.6%, indicating further 
impairment of lake water. This increase translates to an increased mean Total 
Phosphorous load of 31.321 μg/L (for an absolute increase of 7.153 μg/L). 
Using the regression results described above (Table 13), this translates to 
0.773-m decrease in Secchi depth, and an approximate $7,000 decrease in 
the selling price of the average single family residential dwelling within the 
study area (see Table 2). 
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4 Deliverables Completed 

1. Project report: The project final report presented here describes all data, 
methods and results produced by this study. 

 

2. Presentation of Results: The Principal Investigator is currently scheduled to 
present the data, methods, findings and conclusions of this investigation at 
the September 2015 TAC meeting. Additional public presentations are 
currently being scheduled by LCBP project partners. 
 

3. Database transfer: This project produced three databases:  
a. The first is a compilation of the literature search which includes a table 

of literature that was reviewed and a user interface that facilitates 
guided author or keyword searches that direct the user to annotated 
descriptions of the literature resources. 

b. The second is a compilation of the derived data that was used to 
estimate the econometric models. This database is comprised primarily 
of spatial data that can be used for additional spatial analysis and map 
production. 

c. The third is a compilation of all of the source data in its original format 
as acquired by the Prinicipal Investigator. This meets the requirements 
established in the Project QAPP (Section 5.2). 

 

5 Conclusions 

Project Summary 
The regional economy, quality of life and tourism rely on clean water in Lake 
Champlain and its surrounding basin. This project explored the relationship(s) 
between water quality and property valuation, tourism expenditures and 
economic activity to quantify the contribution of the natural amenities offered 
by the Lake to the regional economy. The project was designed to explore the 
value of clean water in Lake Champlain for two primary classes of 
beneficiaries, residential property owners and tourists. At the regional scale, 
economic flows among sectors were modelled in relation to water quality 
impacts on tourist expenditures for overnight accommodations. Scenario 
analysis was conducted to estimate changes in housing value, tourism 
expenditures and economic impact as a result of changes in water quality, 
water clarity and recreational activities. 
 
A hedonic modelling approach was used to estimate the market value of 
water quality, proximity and views to residential real estate in Vermont towns 
near Lake Champlain. The results highlight the importance of a clean, healthy 
lake to the regional property market. For example, in Georgia, VT, the 
assessment of 37 properties adjacent to St. Albans Bay was reduced by 
$50,000 each representing a net loss of more than $1.8 million from the 
town’s tax rolls (Vermont Public Radio, 2015). In this study, for both single 
family residential and seasonal home purchasers, higher water quality was 
associated with increased property selling price. A one-unit increase in Secchi 
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disk depth is equated with nearly 3% and 37% increases in selling prices for 
single family residential and seasonal homes, respectively.  
 
A strong correlation between Total Phosphorous and Secchi disk 
measurements was found. This finding was used to translate phosphorous 
loading recommendations and predictions for the Lake Champlain basin 
TMDL and water quality impacts from climate change. The increased 
phosphorous load associated with climate change is estimated to result in a 
$4,900 and $53,000 price decrease per average single family dwelling and 
seasonal residence, respectively. Lake clean up and load reductions 
associated with meeting mandated TMDL targets are estimated to result in a 
$5,700 or $61,000 price increase per average single family dwelling and 
seasonal residence, respectively. These two scenarios represent plausible 
ends of the price spectrum. It is likely that the price signal is non-linear (Boyle, 
Poor and Taylor, 1999) and that at some level of water quality improvement 
the marginal return would trend towards zero. 
 
At the sub-regional scale, the relationship between tourism expenditures on 
overnight accommodations and Secchi disk depth was explored. Findings for 
the peak summer months of July and August indicate a significant impact on 
tourism spending related to changes in water clarity. After normalizing town-
level expenditures by the estimated number of rooms per town a linear 
regression model estimated a $2,303 decrease per average lodging unit per 
meter of water clarity decline in each town. Extrapolating to the five-town 
scale concludes that a one-meter decline in water quality is expected to lead 
to a 10% decrease ($110,544) in room expenditures for the month of August. 
 
Finally, at the regional scale an input-output model was constructed for the 
lakeshore economy surrounding Lake Champlain. Four counties in Vermont 
and two counties in New York were included in the analysis. The IMPLAN 
SAM software and county-level employment, income, household 
characteristics and industry make-up tables were used to assess the 
economic connections among sectors. The six-county region is predominately 
a service sector economy, with significant employment in professional 
services, retail trade and the health care sector. The county economies are 
more similar than different, with the top seven sectors for the region all 
represented in the top ten for each county. Additionally, the top ten sectors by 
employment account for 70-74% of the total employment for each county.  
 

A four-county Vermont model found that tourism expenditures feature a 
corresponding multiplier effect that ripples through the regional economy as 
every dollar of lake-related tourism activity generates an additional $0.57 in 
labor income alone, $0.62 in other value added (taxes, property income, 
profits), and all together an additional $0.60 in total output in the region. 
Similarly, the lake tourism economy creates an additional 0.4 jobs in 
supporting and induced activities for every new job. The $300 million in 
annual tourist spending in the four lakeside counties of Vermont generates an 
additional $72.75 million in spending and nearly 1,070 jobs. 
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Secchi disk depth data regressed against room receipt data revealed an 
estimated impact on lodging revenue ranging between 6.5% in July to 10.3% 
in August from a one-meter loss of water clarity. Assuming that 50% of all 
lake-based tourism spending within the basin occurs during the months of 
July and August, a one-meter decrease in water clarity would lead to the loss 
of 195 full-time equivalent jobs, a $12.6 million reduction in tourism 
expenditures and a total economic reduction of nearly $16.8 million. 
 
Lessons Learned and Future Opportunities 
This project reaffirms the importance of a healthy Lake Champlain to the 
condition of the regional economy as reflected in property valuation, tourism 
expenditures and economic activity between various sectors. The project 
evaluated the influence of water quality influence on different aspects of 
valuation across all three spatial scales. A mechanism was established to use 
the findings from the sub-regional model to inform scenario development at 
the regional scale. 
 
Data acquisition and processing, particularly for the real estate transaction 
data, presented a number of challenges, not the least of which is the storage 
of different parcel-level information in multiple formats with varying reference 
IDs. The process of data conflation is both technically challenging (with 
respect to process automation) and time consuming (since most of this effort 
was conducted manually). While these types of data limitations were 
overcome through the use of proxies (e.g. assessed value in the place of 
detailed, household-level structural information), they effectively limit the 
scope of the analysis due to the data assembly effort involved for broadening 
the spatial and temporal scales of analysis. 
 
The development of the regional-scale input-output model was relatively 
straightforward (compared to the parcel-scale hedonic model). Customized 
economic activity clusters were designed to focus on impacts to (and from) 
household and tourism-related expenditures and their magnitude relative to 
the regional economy. Limited scenarios analysis was conducted; however, 
possible scenario types ranging from individual events (e.g. fishing 
tournaments) to long-term environmental and economic conditions could be 
further analysed given a set of input conditions. This type of approach could 
allow for a rapid assessment of the economic impacts of anything from land 
use plans and zoning regulations, to environmental restoration and mitigation 
efforts, to regional economic development strategies. Outputs from these 
types of analyses could support decision-making for effective policy 
formulation and implementation. 
 
This analysis represents a snapshot in time, and although the Secchi disk 
measurement parameter was averaged over time, the analysis in general 
lacks temporal specifications that could better reveal lagged effects (i.e. 
across multiple seasons or years) between changes in water quality and 
human perception of Lake suitability and its influence on economic decision 
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making (e.g. where to buy a house, go on vacation). The example of Georgia, 
VT reveals that a continued downward water quality trend has real (and 
lasting) impacts on the local housing market, affecting town-level appraisal, 
real estate transactions, vacation rentals and tourism expenditures. Losses in 
one or more of these sectors are further magnified when considering their 
effect on employment and indirect expenditures. 
 
The importance of targeted survey data capturing consumer perspectives on 
topics ranging from real estate preferences to factors influencing vacation 
decisions and economic development should not be underestimated. In the 
absence of this information, proxy data were used. However, the roots of the 
economic analysis presented here are a series of individual (and oftentimes 
personal) financial decisions that scale to the regional economy. A set of well-
crafted survey instruments designed for specific target audiences (e.g. 
homebuyers, business owners) could help understand spending and 
investment differentials throughout the Lake. Survey findings could be used to 
improve or enhance existing model specifications whose results in turn could 
inform the development of a long-term economic development plan that 
addresses potential climate change impacts, includes measures to improve 
environmental quality and expand the lake-based tourism market throughout 
the basin. 
 
This effort represents a step towards understanding the relationship(s) and 
interdependencies of economic actors, current and future economic 
development and local- to regional environmental conditions. Generally 
speaking, this project and potential future extensions of the work presented 
here could be used to address several of the tasks included in the LCBP’s 
Opportunities for Action.  Project findings could inform the public about the 
economic implications of lake water quality. Actions 3.1 and 4.5 could include 
the development of educational materials that connect individual decisions to 
water quality metrics. This connection in turn establishes a context for 
understanding the sectors of the economy that are strongly influenced by the 
overall health of the Lake. The modelling framework developed for this project 
could also be used to address Actions 10.1.2, 10.2 and 10.3.1. The scenario 
analysis capabilities could easily be extended to encompass additional policy 
and management questions related to restoration and mitigation activities and 
prioritizing spending on such efforts to maximize return on investment. Finally, 
economic indicators (e.g. real estate valuation, visitation rates and 
expenditures, employment opportunities and economic development) 
estimated by modelling a range of potential policy and climate alternatives 
could lead to more informed watershed management plans and economic 
development strategies. 
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7 Appendices  

Appendix I: Quality Assurance Tasks Completed 
Primary data resources 
All data for the econometric models were obtained from one of five sources: 

1. Vermont Center for Geographic Information (VCGI), a division of the 
Agency of Commerce and Community Development. VCGI is the lead 
agency in charge of geospatial data storage and dissemination in the 
State of Vermont. 

2. Vermont Department of Taxes, a division of the Agency of 
Administration. The Department of Taxes maintains state-wide records 

http://www.ucl.ac.uk/bioecon/11th_2009/Villa.pdf
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pertaining to real estate transactions and meals and rooms 
expenditures. This department is the only source for these data in the 
State of Vermont. The real estate transaction data underwent a 
thorough review by the Principal Investigator to ensure the deletion of 
duplicate records and elimination of records with incomplete attribution. 
These data were geocoded using the address field in both the real 
estate transaction data and the state-wide E911 data. Transaction data 
without a corresponding address record in the E911 dataset were 
eliminated from the database. 

3. Vermont Department of Environmental Control / Lake Champlain Basin 
Program Lake Champlain Long-term Water Quality and Biological 
Monitoring Project. These data are collected by the New York State 
Department of Environmental Conservation and the Vermont 
Department of Environmental Conservation in collaboration with the 
Lake Champlain Basin Program. The program includes data collection 
to monitor water quality and biological conditions within the Lake. The 
Quality Assurance Project Plan for this program can be found online at 
www.watershedmanagement.vt.gov/lakes/docs/lp_2015ltmpqapp.pdf. 

4. US Geological Survey - The National Map. The National Map is the 
primary outlet for national scale elevation and land cover data. As 
such, data from The National Map were the best available because of 
the spatial extent of their coverages and their temporal proximity (in 
particular the 2011 National Land Cover Dataset (2011 NLCD)) to 
many of the other primary datasets, including the real estate 
transaction data, the meals and rooms expenditures and the water 
quality monitoring data. Data served by The National Map have 
undergone extensive review, meet all federally established data 
standards and are internationally recognized as being of high quality. 

5. Claritas, Inc. 2103 employment data for the State of Vermont was 
purchased from this commercial data vendor. This data was purchased 
for another project that the Principal Investigator worked on, and no 
funds from this project were spent on its acquisition. The data are of 
the highest quality available and are routinely used for complex 
economic analysis and land use planning applications. Although there 
are certainly other vendors distributing this data, they all originate from 
the same source, and no funding was requested to support additional 
data acquisition.  

 

The 2013 IMPLAN database for Vermont and New York counties was 

purchased from the IMPLAN Group, LLC who also developed the 

IMPLAN System (data and software) used in the analysis. The data 
represent a system of economic accounts based on national input-output 
tables produced by the Bureau of Economic Analysis and tailored for county-
level employment, income, household characteristics and industry make-up 
(see www.implan.com). Scenario data for the IO model was developed using 
data from the Vermont Department of Taxes and the Lake Champlain Long-
term Water Quality Monitoring Program, both of which are described above. 
 

http://www.implan.com/
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Table 14: List of primary data sources included in one or more models described in the 
project report. 

Dataset Name Source Description of Use 
Real estate 
transaction data 

Vermont 
Department of 
Taxes 

Selling price information used as the 
dependent variable in the hedonic 
model. Parcel size and assessed value 
used as independent variables in the 
hedonic model. 

Lake Champlain 
Boundary 

VCGI Used to delineate 100-m buffer zone 
and compute the amount of lake 
visibility from real estate transaction 
locations. 

Recreation Sites VCGI Combined fishing access locations with 
other recreational sites on the lakeshore 
and then derived proximity measures 
between them and the transaction 
locations. 

Roads VCGI The E911 roads dataset was used to 
build the transportation network that 
served as the primary input for 
computing proximity measures and 
service areas around transaction 
locations. 

Employment Claritas, Inc. The employment data was split 
according to generalized NAICS 
classifications (e.g. Service, Industrial, 
Finance) and then used to compute the 
proximity of transaction locations to 
different types of commercial 
establishments. 

E911 Sites VCGI The E911 data were used to geocode 
the real estate transaction data and the 
employment data. This data represents 
the most complete database of 
georeferenced residential and non-
residential addresses in the State of 
Vermont. 

Town and County 
Boundaries 

VCGI The town and county boundaries data 
were used to define the spatial extents 
of the various models in the project.  

Demographics VCGI – US 
Census Bureau 

Data from the 2010 Decennial Census 
of the Population were used as 
independent variables in the hedonic 
model. 

Water Quality 
Monitoring Data 

VT DEC The water quality monitoring data was 
used as an independent variable in the 
hedonic model and the tourism 
expenditure model, and was used as an 
input to the scenario development 
process for the IO model. 

2011 National Land 
Cover Dataset  

USGS – The 
National Map 

The 2011 NLCD was used to identify 
specific land cover classes (e.g. 
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Dataset Name Source Description of Use 
forested) for inclusion as an 
independent variable in the hedonic 
model. However, none of the derived 
land cover parameters were found 
significant. 

Digital Elevation 
Model (DEM) 

USGS – The 
National Map 

The DEM was one of two primary inputs 
for the viewshed analysis that 
determined the amount of Lake visibility 
from each of the transaction locations. 

 

Data Storage 
Secondary data collected for this project is currently stored on the UVM 
central network. Data is backed up on a regular basis according to UVM 
network protocols. All of the data includes documentation of the data source, 
date collected, and provider contact information. A guide to the primary data is 
provided in Table 14, and a complete list of derived data is included in 
Appendix I: Data Documentation and as a standalone spreadsheet. 
Techniques used to derive, interpret and display data in the report has been 
documented, is stored on the UVM central network and is available to the 
public upon inquiry. The data will remain on the UVM central network for a 
period of at least 2 years and can be accessed via a request to the Principal 
Investigator. 
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Appendix II: Quality Assurance Tasks Completed 
 

IMPLAN Sector Description 
3-digit NAICS 

Sector 

1 Crop Farming 1-10 

11 Animal Production 11-14 

15 Forestry & logging 15-16 

17 Fishing, hunting & trapping 17-18 

19 Support for agriculture & forestry 19 

20 Mining & energy extraction 20-40 

41 Utilities 41-51 

52 Construction, maintenance, & repair 52-64 

65 Food & drink manufacturing 65-110 

111 Tobacco, fiber, and apparel 111-133 

134 Wood products manufacturing 134-153 

154 Printing 154-155 

156 Petrochemicals & chemicals 156-168 

169 Fertilizer, pesticide & agrochemical 169-172 

173 Medicinal & pharmaceutical 173-176 

177 Other chemical manufacturing 177-187 

188 Plastic products 188-195 

196 Rubber products 196-198 

199 Cement, glass & other nonmetallic products 199-216 

217 Metals 217-233 

234 Fabricated metal manufacturing 235-261 

262 Industrial machinery manufacturing 262-271 

272 Instrument & equipment manufacturing 272-300 

301 Computers & electronics 301-313 

314 Control & measurement devices 314-324 

325 Lights & appliances 325-331 

332 Electrical equipment manufacturing 332-342 

343 Transportation manufacturing 343-367 

368 Other manufacturing 368-394 

395 Wholesale trade 395 

396 Retail trade 396-407 

408 Transportation & warehousing 408-416 

417 Publishing, entertainment & 
telecommunications 

417-432 

433 Finance, insurance & real estate 433-440 

441 Owner occupied dwellings 441 

442 Rentals & leasing 442-446 

447 Professional services 447-471 
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IMPLAN Sector Description 
3-digit NAICS 

Sector 

472 Education 472-474 

475 Health care 475-484 

485 Family & community services 485-487 

488 Arts & recreation 488-498 

499 Hotels & accommodations 499-500 

501 Restaurants & drinking places 501-503 

504 Auto & equipment repair 504-508 

509 Personal services 509-512 

513 Non-governmental organizations 513-516 

517 Private households 517 

518 Federal government enterprises 518-520 

521 State & local government enterprises 512-526 

527 Not an industry 527-530 

531 State & local gov't payroll, non-education 531, 533 

532 State & local gov't payroll, education 532, 534 

535 Federal gov't payroll 535-536 
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Appendix III: Data Documentation 
Lake Champlain Recreation Access Points 
1. Download TourismRecreation_FISHACCESS.zip from vcgi.vermont.gov 

>>> \LCBP\Hedonic\zips\TourismRecreation_FISHACCESS.zip 
2. Unzip TourismRecreation_FISHACCESS.zip >>> 

\LCBP\Hedonic\incoming\FishAccess\ 
3. Download TourismRecreation_RECSITES.zip from vcgi.vermont.gov >>> 

\research\LCBP\Hedonic\zips\TourismRecreation_RECSITES 
4. Unizip TourismRecreation_RECSITES.zip >>> 

\LCBP\Hedonic\incoming\RecreationSites\ 
5. Select By Location from TourismRecreation_FISHACCESS, 

TourismRecreation_RECSITES ALL RECORDS WITHIN 100m of 
LakeChamplain_step1 (FISHACCESS = 29 records selected, RECSITES 
= 113 records selected) 

6. Export selected FISHACCESS records >>> 
\LCBP\Hedonic\hedonic_scratch.mdb\FishAccess_step1 

7. Export selected RECSITES records >>> 
\LCBP\Hedonic\hedonic_scratch.mdb\RecreationSites_step1 

8. Select By Attributes from RecreationSites_step1 WHERE [PUBLIC_PRI] = 
1 (69 records selected) 

9. Export selected records >>> 
\LCBP\Hedonic\hedonic_scratch.mdb\RecreationSites_step2 

10. Select By Attributes from RecreationSites_step2 WHERE [BOATING_MA] 
= 'Y' OR [SWIMMING] = 'Y' (42 records selected) 

11. Export selected records >>> 
\LCBP\Hedonic\hedonic_scratch.mdb\RecreationSites_step3 

12. Export RecreationSites_step3>>> 
\LCBP\Hedonic\hedonic_scratch.mdb\RecreationSites_step4 

13. Analysis Tools > Proximity > Near WHERE INPUT = 
RecreationSites_step4, NEAR FEATURE = RecreationSites_step3 

14. Turn off extraneous fields in RecreationSites_step4 
15. Export RecreationSites_step4 >>> 

\LCBP\Hedonic\hedonic.mdb\DistanceToRecreationSites 
 

Proximity to Lake Champlain 
1. Download NHDH_VT_931v220.zip from vcgi.vermont.gov >>> 

NHDH_VT_931v220.zip 
2. Unzip geodatabase >>> NHDH_VT.gdb 
3. Select By Attributes from NHDWaterbody WHERE GNIS_Name = 'Lake 

Champlain' (1 record selected) 
4. Export selected record >>> 

\LCBP\Hedonic\hedonic_scratch.mdb\LakeChamplain_step1 
5. Export PT_step8_ALL 

>>>\LCBP\Hedonic\hedonic_scratch.mdb\DistanceToLakeChamplain_step
1 

6. Analysis Tools > Proximity > Near WHERE INPUT = 
DistanceToLakeChamplain_step1, NEAR FEATURE = 
LakeChamplain_step1 
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7. Export DistanceToLakeChamplain_step1 >>> 
\LCBP\Hedonic\hedonic.mdb\DistanceToLakeChamplain 

 

Employment 
(This data was purchased from a proprietary data supplier and is not available 
to be shared in its original format. Derived data products are described here 
and included in the project database.) 
1. ArcMap > right click StatewideEmployment_step1 > Display XY Data using 

NewX and NewY as the coordinates 
2. Data Management Tools > Features > Copy Features WHERE INPUT = 

StatewideEmployment_step1 >>> 
\LCBP\Hedonic\EmploymentAnalysis_scratch.gdb\StatewideEmployment_
step2 

3. Select By Attributes from StatewideEmployment_step2 WHERE 
NAICS_string LIKE '7221%' (1133 records selected) 

4. Export selected records >>> 
\LCBP\Hedonic\EmploymentAnalysis_scratch.gdb\StatewideEmployment
_FullServiceRestaurants 

5. Select By Attributes from StatewideEmployment_step2 WHERE 
NAICS_string LIKE '7221%' or NAICS_string LIKE '7222%' (1413 records 
selected) 

6. Export selected records >>> 
\LCBP\Hedonic\EmploymentAnalysis_scratch.gdb\StatewideEmployment
_AllRestaurants 

7. Select By Attributes from StatewideEmployment_step2 WHERE 
NAICS_string LIKE ('111%') OR NAICS_string LIKE ('112%') OR 
NAICS_string LIKE ('114*') OR NAICS_string LIKE ('115*') (451 records 
selected) 

8. Export selected records >>> 
\LCBP\Hedonic\EmploymentAnalysis_scratch.gdb\StatewideEmployment
_Agriculture 

9. Select By Attributes from StatewideEmployment_step WHERE 
NAICS_string LIKE '113%' OR NAICS_string LIKE '321%' OR 
NAICS_string LIKE '311%' OR NAICS_string LIKE '313%' OR 
NAICS_string LIKE '236%' OR NAICS_string LIKE '211%' OR 
NAICS_string LIKE '221%' OR NAICS_string LIKE '322%' OR 
NAICS_string Like '312%' OR NAICS_string Like '314%' OR NAICS_string 
Like '237%' OR NAICS_string Like '212%' OR NAICS_string Like '323%' 
OR NAICS_string Like '315%' OR NAICS_string Like '238%' OR 
NAICS_string Like '213%' OR NAICS_string Like '324%' OR NAICS_string 
Like '316%' OR NAICS_string Like '325%' OR NAICS_string Like '326%' 
OR NAICS_string Like '327%' OR NAICS_string Like '331%' OR 
NAICS_string Like '332%' OR NAICS_string Like '333%' OR NAICS_string 
Like '334%' OR NAICS_string Like '335%' OR NAICS_string Like '336%' 
OR NAICS_string Like '337%' OR NAICS_string Like '339%' (4619 records 
selected) 
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10. Export selected records >>> 
\LCBP\Hedonic\EmploymentAnalysis_scratch.gdb\StatewideEmployment
_Industrial 

11. Select By Attributes from StatewideEmployment_step2 WHERE 
NAICS_string LIKE '44%' OR NAICS_string LIKE '45%' (5412 records 
selected) 

12. Export selected records >>> 
\LCBP\Hedonic\EmploymentAnalysis_scratch.gdb\StatewideEmployment
_Retail 

13. Select By Attributes from StatewideEmployment_step2 WHERE 
NAICS_string LIKE '52%' OR NAICS_string LIKE '531%' OR NAICS_string 
LIKE ''533%' (2364 records selected) 

14. Export selected records >>> 
\LCBP\Hedonic\EmploymentAnalysis_scratch.gdb\StatewideEmployment
_Finances 

15. Select By Attributes from StatewideEmployment_step2 WHERE 
NAICS_string LIKE '511%' OR NAICS_string LIKE '512%' OR 
NAICS_string LIKE '515%' OR NAICS_string LIKE '517%' OR 
NAICS_string LIKE '518%' OR NAICS_string LIKE '532%' OR 
NAICS_string LIKE '54%' OR NAICS_string LIKE '55%' OR NAICS_string 
LIKE '56%' OR NAICS_string LIKE '62%' OR NAICS_string LIKE '721%' 
OR NAICS_string LIKE '722%' OR NAICS_string LIKE '81' (13246 records 
selected) 

16. Export selected records >>> 
\LCBP\Hedonic\EmploymentAnalysis_scratch.gdb\StatewideEmployment
_Service 

17. Select By Attributes from StatewideEmployment_step2 WHERE 
NAICS_string LIKE '221%' (87 records selected) 

18. Export selected records >>> 
\LCBP\Hedonic\EmploymentAnalysis_scratch.gdb\StatewideEmployment
_Utilities 

19. Select By Attributes from StatewideEmployment_step2 WHERE 
NAICS_string LIKE '711%' OR NAICS_string LIKE '712%' (414 records 
selected) 

20. Export selected records >>> 
\LCBP\Hedonic\EmploymentAnalysis_scratch.gdb\StatewideEmployment
_CulturalAttractions 

21. Select By Attributes from StatewideEmployment_step2 WHERE 
NAICS_string LIKE '61%' (XXX records selected) 

22. Export selected records >>> 
\LCBP\Hedonic\EmploymentAnalysis_scratch.gdb\StatewideEmployment
_Education 

23. Select By Attributes from StatewideEmployment_step2 WHERE 
NAICS_string = '445110' OR NAICS_string LIKE '4452%' (483 records 
selected) 

24. Export selected records >>> 
\LCBP\Hedonic\EmploymentAnalysis_scratch.gdb\StatewideEmployment
_Grocery 
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E911 
1. Download EmergencyE911_ESITE .zip from vcgi.vermont.gov >>> 

EmergencyE911_ESITE.zip 
2. Unzip archive >>> \Hedonic\incoming\E911\Emergency_ESITE_point 
3. Select By Location from Emergency_ESITE_point ALL RECORDS THAT 

INTERSECT PrimarySecondaryTowns (92,755 records selected) 
4. Export selected records >>> \E911_scratch.mdb\E911_ESITE_step1 
5. Select By Attribute from E911_ESITE_step1 WHERE [SITETYPE] In ( 

'CAMP', 'MOBILE HOME', 'MULTI-FAMILY DWELLING', 'OTHER 
RESIDENTIAL', 'RESIDENTIAL FARM', 'SEASONAL HOME', 'SINGLE 
FAMILY DWELLING') (79,250 records selected) 

6. Export selected records >>> 
\Hedonic\incoming\E911\E911_scratch.mdb\E911_ESITE_step2 
(residential) 

7. Select By Attribute from E911_ESITE_step1 WHERE [SITETYPE] In ( 
'ACCESSORY BUILDING', 'AIR SUPPORT / MAINTENANCE FACILITY', 
'AIRPORT TERMINAL', 'AMBULANCE SERVICE', 'BANK', 'BOAT RAMP / 
DOCK', 'BORDER PATROL', 'CAMP', 'CAMPGROUND', 'CITY / TOWN 
HALL', 'COAST GUARD', 'COLLEGE / UNIVERSITY', 'COMMERCIAL', 
'COMMERCIAL FARM', 'COMMERCIAL GARAGE', 'COMMERCIAL 
W/RESIDENCE', 'COMMUNICATION BOX', 'COMMUNICATION 
TOWER', 'COMMUNITY / RECREATION CENTER', 'COMMUNITY / 
RECREATION FACILITY', 'DAY CARE FACILITY', 'DEVELOPMENT 
SITE', 'EDUCATIONAL', 'FIRE STATION', 'GAS STATION', 'GATED 
W/BUILDING', 'GOLF COURSE', 'GOVERNMENT', 'GREENHOUSE / 
NURSERY', 'GROCERY STORE', 'HAZARDOUS MATERIALS FACILITY', 
'HEALTH CLINIC', 'HELIPAD / HELIPORT / HELISPOT', 'HISTORIC SITE 
/ POINT OF INTEREST', 'HOUSE OF WORSHIP', 'HYDROELECTRIC 
FACILITY', 'INDUSTRIAL', 'INSTITUTIONAL RESIDENCE / DORM / 
BARRACKS', 'LANDFILL', 'LAW ENFORCEMENT', 'LIBRARY', 
'LODGING', 'MINE', 'MOBILE HOME', 'MULTI-FAMILY DWELLING', 
'NURSING HOME / LONG TERM CARE', 'OFFICE BUILDING', 'OIL / GAS 
FACILITY', 'OTHER', 'OTHER COMMERCIAL', 'OTHER RESIDENTIAL', 
'PARK AND RIDE / COMMUTER LOT', 'POST OFFICE', 'PRISON / 
CORRECTIONAL FACILITY', 'PUBLIC GATHERING', 'PUBLIC 
TELEPHONE', 'PUBLIC WATER SUPPLY WELL', 'PUMP STATION', 
'RACE TRACK / DRAGSTRIP', 'RADIO / TV BROADCAST FACILITY', 
'RAILROAD STATION', 'RESIDENTIAL FARM', 'RESTAURANT', 'RETAIL 
FACILITY', 'RV HOOKUP', 'SCHOOL', 'SEASONAL HOME', 'SINGLE 
FAMILY DWELLING', 'SOLAR FACILITY', 'STATE GOVERNMENT 
FACILITY', 'STORAGE UNITS', 'SUBSTATION', 'TEMPORARY 
STRUCTURE', 'TOWN GARAGE', 'TOWN OFFICE', 'US GOVERNMENT 
FACILITY', 'UTILITY', 'UTILITY POLE W/PHONE', 'VETERINARY 
HOSPITAL / CLINIC', 'VISITOR / INFORMATION CENTER', 
'WAREHOUSE', 'WASTE / BIOMASS FACILITY', 'WASTEWATER 
TREATMENT PLANT', 'WATER TANK', 'WATER TOWER', 'WIND 
FACILITY / WIND TOWER') (185,279 records selected) 
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8. Export selected records >>> 
\Hedonic\incoming\E911\E911_scratch.mdb\E911_ESITE_step3 (general 
development density) 

9. Spatial Analyst Tools > Density > Point Density WHERE INPUT = 
E911_ESITE_step2, POPULATION FIELD = NONE, CELL SIZE = 10, 
NEIGHBORHOOD = CIRCLE, RADIUS = 500m >>> 
\LCBP\Hedonic\incoming\E911\E911_scratch.mdb\ResidentialDevelopm
entDensity 

10. Run model ResidentialDensityAnalyzer to calculate zonal statistics on 
ResidentialDevelopmentDensity within 1- and 5-km boundaries 
surrounding each real estate transaction point 
a. This step uses ArcGIS ModelBuilder to iterate over all of the 

transaction point data to compute residential density values for 1- and 
5-km boundaries 

 

Town Boundaries 
1. Select By Location from Boundary_BNDHASH_region_towns ALL 

RECORDS THAT INTERSECT PT_step8_ALL (23 records selected) 
2. Export selected records >>> \Hedonic\hedonic.mdb\PrimaryTowns 
3. Select By Location from Boundary_BNDHASH_region_towns ALL 

RECORDS THAT SHARE A LINE SEGMENT WITH PrimaryTowns (45 
records selected) 

4. Export selected records >>> 
\Hedonic\hedonic.mdb\PrimarySecondaryTowns 

 

US Census 
1. Download DemoCensus_BLCKGR2010.zip from vcgi.vermont.gov >>> 

DemoCensus_BLCKGR2010.zip 
2. Unzip archive >>> 

\Hedonic\incoming\Census\DEMO_BLCKGR2010_POLY 
3. Select By Location from DEMO_BLCKGR2010_POLY ALL RECORDS 

THAT INTERSECT PropertyTransfer_ALL (98 records selected) 
4. Export selected records >>> 

\Hedonic\incoming\Census\Census_scratch.mdb\BlockGroup2010_step1 
5. Join BlockGroup2010_step1 to PropertyTransfer_ALL based on SPATIAL 

LOCATION >>> 
\Hedonic\incoming\Census\Census_scratch.mdb\BlockGroup2010_step2 

6. Turn off extraneous fields from Layer Properties 
7. Export _step2 >>> 

\Hedonic\incoming\Census\Census_scratch.mdb\BlockGroup2010_step3 
8. Export _step3 >>> \Hedonic\hedonic.mdb\BlockGroup2010 

 

Water Quality Monitoring Stations 
1. Used Table 1 in the report found at 

http://www.watershedmanagement.vt.gov/lakes/docs/lcmonitoring/lp_lclon
gtermprogdesc.pdf to identify the coordinates for the 15 long-term lake 
monitoring stations >>> 
\Hedonic\incoming\WaterQuality\LCBPMonitoringStations.xlsx 

2. Display X,Y data >>> creates a temporary file 
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3. Export temporary file >>> 
\Hedonic\incoming\WaterQuality\WaterQuality_scratch.mdb\WaterQualityS
tations_step1 

4. Data Management Tools > Projections and Transformations > Features > 
Project WHERE INPUT = WaterQualityStations_step1, COORDINATE 
SYSTEM = NAD83, VT State Plane, m >>> 
\Hedonic\incoming\WaterQuality\WaterQuality_scratch.mdb\WaterQualityS
tations_step2 

5. Export PropertyTransfer_ALL >>> 
\Hedonic\incoming\WaterQuality\WaterQuality_scratch.mdb\WaterQualityS
tations_step3 

6. Analysis Tools > Proximity > Near WHERE INPUT FEATURES = 
WaterQualityStations_step3, NEAR FEATURES = 
WaterQualityStations_step2 

7. Add field StationID to WaterQualityStations_step3 AS INTEGER 
8. Join WaterQualityStations_step2 to WaterQualityStations_step3 on 

OBJECTID and NEAR_FID, respectively 
9. Calculate WaterQualityStations_step3.StationID = 

WaterQualityStations_step2.StationID 
10. Download the data tables for each of the sensors from 

http://www.watershedmanagement.vt.gov/lakes/htm/lp_longterm.htm 
 

National Land Cover Dataset 
1. Download 2011 NLCD for Vermont and New York from The National Map 

>>> \LCBP\Hedonic\zips\NLCD2011_LC_New_York & 
NLCD2011_LC_Vermont 

2. Unzip archives >>> 
\LCBP\Hedonic\incoming\LandCover\NLCD2011_LC_New_York & 
NLCD2011_LC_Vermont 

3. Data Management Tools > Projections and Transformations > Raster > 
Project Raster WHERE INPUT = NLCD2011_LC_Vermont, OUTPUT 
COORDINATE SYSTEM = 
NAD_1983_2011_StatePlane_Vermont_FIPS_4400 
\LCBP\Hedonic\LandCoverAnalysis_scratch.mdb\NLCD2011_VT_step1 

4. Data Management Tools > Projections and Transformations > Raster > 
Project Raster WHERE INPUT = NLCD2011_LC_New_York, OUTPUT 
COORDINATE SYSTEM = 
NAD_1983_2011_StatePlane_Vermont_FIPS_4400 >>> 
\LCBP\Hedonic\LandCoverAnalysis_scratch.mdb\NLCD2011_NY_step1 

5. Data Management Tools > Raster > Raster Dataset > Mosaic to New 
Raster > WHERE INPUT = NLCD2011_NY_step1 & 
NLCD2011_VT_step1 >>> 
\LCBP\Hedonic\LandCoverAnalysis_scratch.mdb\NLCD2011_step1 

6. Spatial Analyst Tools > Extraction > Extract by Mask WHERE INPUT = 
NLCD2011_step1, MASK = HUC8_step1 >>> 
\LCBP\Hedonic\LandCoverAnalysis_scratch.mdb\NLCD2011_step2 

7. Run model TabulateArea to tabulate the area of different land cover types 
(from NLCD2011_step2) within the 5-km buffer regions surrounding real 

http://www.watershedmanagement.vt.gov/lakes/htm/lp_longterm.htm
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estate transaction points >>> 
\LCBP\Hedonic\LandCoverAnalysis_scratch.gdb\TabulateLandCover5km_
%Iterator% 
a. This step uses ArcGIS ModelBuilder to iterate over all of the 

transaction point data to land cover characteristics for 1- and 5-km 
boundaries 
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Appendix IV: Literature review of hedonic pricing model parameters 

 
Property Studies Using 

Lot Size Loomis and Feldman 2003,  Bejranonda et 
al. 1999, Michael et al. 2000,  Orr and 
Pickens 2003, Boatwright et al. 2013, Zhang 
and Boyle 2010 

Number of bathrooms Loomis and Feldman 2003, Bejranonda et al. 
1999, Kashian et al. 2006, Boatwright et al. 
2013,  Boyle et al. 1999, Poor et al. 2007, 
Zhang and Boyle 2010 

Building size / living area Loomis and Feldman 2003, Bejranonda et al. 
1999, Gibbs et al. 2002, Michael et al. 2000, 
Boyle et al. 1999, Kashian et al. 2006, 
Lansford and Jones 1995, Poor et al. 2001,  
Boatwright et al. 2013, Zhang and Boyle 
2010,  Michael et al. 1996 

Garage Loomis and Feldman 2003, Bejranonda et al. 
1999, Michael et al. 2000, Kashian et al. 
2006, Lansford and Jones 1995, Michael et 
al. 1996 

Adjacent to golf course Loomis and Feldman 2003 

Mortgage interest rate Loomis and Feldman 2003 

Number of rooms Bejranonda et al. 1999 

Building age yrs, yrs 
sqrd,  

Bejranonda et al. 1999, Gibbs et al. 2002, 
Boatwright et al. 2013,  Yoo et al. 2014 

Air conditioning Bejranonda et al. 1999, Kashian et al. 2006 

Heat Bejranonda et al. 1999, Michael et al. 2000, 
Boyle et al. 1999, Poor et al. 2007, Zhang 
and Boyle 2010,  Michael et al. 1996 

Basement Bejranonda et al. 1999, Michael et al. 2000, 
Kashian et al. 2006,  Michael et al. 1996 

Fireplace Bejranonda et al. 1999, Kashian et al. 2006 

Patio / deck / porch Bejranonda et al. 1999, Michael et al. 2000, 
Michael et al. 1996 

Full plumbing Gibbs et al. 2002, Michael et al. 2000,  
Michael et al. 1996 

Tax rate in yr of 
purchase 

Gibbs et al. 2002, Michael et al. 2000,  
Michael et al. 1996 

More than one story Michael et al. 2000,  Poor et al. 2007,  
Michael et al. 1996 

Number of fireplaces Michael et al. 2000,  Michael et al. 1996 

Septic system or town 
septic 

Michael et al. 2000,  Michael et al. 1996 

Public road Michael et al. 2000,  Michael et al. 1996 
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Property Studies Using 

Assessed land and / or 
property value 

Kashian et al. 2006, Orr and Pickens 2003, 
Yoo et al. 2014 

Number of bedrooms Kashian et al. 2006 

Month / Year of sale Lansford and Jones 1995, Orr and Pickens 
2003, Boatwright et al. 2013 

Carport spaces Lansford and Jones 1995 

Street frontage Lansford and Jones 1995 

Construction quality Lansford and Jones 1995 

House condition Lansford and Jones 1995 

Stumpage value Orr and Pickens 2003 

Road access  Orr and Pickens 2003 

Current utilities Orr and Pickens 2003 

Potential utilities Orr and Pickens 2003 

Area of ground floor Yoo et al. 2014 

Ratio of patio area to 
floor area 

Yoo et al. 2014 

Ratio of total land full 
cash value to sale rice 

Yoo et al. 2014 

Specific subdivisions Boatwright et al. 2013 

Recreational areas in 
subdivision 

Boatwright et al. 2013 

Commercial Forest Land 
Adjacent 

Orr and Pickens 2003 

Subdivision allowed Orr and Pickens 2003 

Presence of curb / gutter Boatwright et al. 2013 

House is locate on a 
street with a cul-de-sac 

Boatwright et al. 2013 

House is located on a 
narrow street 

Boatwright et al. 2013 

On a bluff Lansford and Jones 1995 

Building present, 
unimproved land 

Orr and Pickens 2003,  Zhang and Boyle 
2010 

  

Natural Amenities Parameters 

Scenic view Lansford and Jones 1995,  Orr and Pickens 
2003 

Length of border with 
public land 

Orr and Pickens 2003 

Adjacent to public land Orr and Pickens 2003 

Open space within a 
0.19 km radius of the 
house 

Boatwright et al. 2013 

Open space has trees Boatwright et al. 2013 
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Property Studies Using 

Proximity Parameters 

Distance to lake / 
distance to lake squared 

Loomis and Feldman 2003,  Bejranonda et 
al. 1999, Lansford and Jones 1995 

Distance to nearest 
central business district/ 
town with pop > 9,000 

Bejranonda et al. 1999,  Gibbs et al. 2002, 
Michael et al. 2000, Boyle et al. 1999, 
Lansford and Jones 1995, Poor et al. 2007, 
Zhang and Boyle 2010,  Michael et al. 1996 

Distance to small town Orr and Pickens 2003 

Distance to large town Orr and Pickens 2003 

  

Neighborhood Parameters 

Housing density lots/ 
1,000 feet of lake 
frontage,  

Gibbs et al. 2002, Michael et al. 2000, Poor 
et al. 2001,  Michael et al. 1996 

Location by school 
system 

Lansford and Jones 1995 

Number of buildings in a 
0.19km radius of house 

Boatwright et al. 2013 

Number of 
population/mile^2 in 
2000 

Yoo et al. 2014 

Number of people with 
at least a college degree 
2000 

Yoo et al. 2014 

Which city Yoo et al. 2014 

  

Demographic Parameters 

County population Bejranonda et al. 1999 

County unemployment Bejranonda et al. 1999 

Median income Boatwright et al. 2013, Yoo et al. 2014 

Percent of population 
that is white 

Boatwright et al. 2013 

 

* Parameters presented in italics were used as dummy variables. Parameters 
presented in bold italics were used as categorical variables. 


